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Landscape Analysis contents

Landscape Analysis narrative: A summary of field capacity

Focus of this document

Relational map of field actors: Connections among field actors
identified through Landscape Analysis
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Relational map of perspectives and frames: Connections among
frameworks and terminology

Landscape Analysis Relational Mapping: background

Purpose

Approach

The relational mapping effort focused on mapping and analyzing organizations in the Landscape
Analysis either primarily or partially focused on SEAD, in order to map and analyze their
relationships with partners and funders inside and outside of the SEAD space.
The team identified 300+ organizations involved in SEAD work through its work on the companion
Landscape Analysis narrative. Additional details on these organizations were gathered into a
comprehensive database including categorizing their approach across the different implementation
levers and reviewing publicly available information on their partners and funders. A network
mapping tool, Touchgraph Navigator, was used to visualize the networks. This tool is available for
download online and easy to use alongside the database.

1. Note public funding and local, state, and federal advocacy levers have been combined for the purpose of this analysis. Therefore there are only 13
segments of field actors shown.
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Context

This Landscape Analysis was conducted April-July 2018 by The Boston Consulting Group in support
of the National Commission, in partnership with Grantmakers for Thriving Youth. The analysis was
organized around 141 implementation levers within which 300+ organizations engaged in work to
support Social, Emotional, and Academic Development (SEAD) were identified. The relational
mapping analysis complements a Landscape Analysis narrative, captured in a separate document.

National Commission's Change Agenda Work Group
The Landscape Analysis was overseen by the National Commission's Change Agenda Work Group, whose members included:
• Jorge Benitez, Former CEO, Accenture North America (Work Group Chair)
• Linda Darling-Hammond, President and CEO, Learning Policy Institute; Charles E. Ducommun Professor of Education, Emerita, Stanford
University (Commission Co-Chair)

• Jackie Jodl, Executive Director of the National Commission
• General Craig McKinley, Four-Star Air Force General (Ret.); Former President and CEO, National Defense Industrial Association
• Karen Pittman, President, CEO, and Co-Founder of The Forum for Youth Investment
• Jim Shelton, President of Education, Chan Zuckerberg Initiative
• Tim Shriver, Co-Founder and Chair, CASEL; Chairman, Special Olympics (Commission Co-Chair)
• Ross Wiener, Vice President, Aspen Institute; Executive Director, Aspen Institute’s Education and Society Program
Additional advising was provided by Itai Dinour (Program Officer, Education, The Einhorn Family Charitable Trust), Will Miller (President, The
Wallace Foundation), Brooke Stafford-Brizard (Director, Chan Zuckerberg Initiative), and Kathleen Traphagen (Lead Facilitator, Grantmakers
for Thriving Youth)
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• Joshua Garcia, Deputy Superintendent of the Tacoma Public Schools

Executive Summary

Relational maps were developed to explore and visualize the connections among these organizations in order to better
understand various dimensions of the SEAD network
• This analysis focused on a subset of 224 actors with either a primary or partial focus on SEAD
• An extensive database was built to document descriptive details about these organizations including publicly-named
partner and funder relationships
Initial review of this relational mapping data highlights several findings that suggest opportunities for growing field
collaboration going forward (see more detailed summary of findings on p12)
• Not surprisingly, philanthropic and convening orgs. are central to the map and key to bringing the network together
• TA Providers and National / Regional associations are more peripheral, potentially due to the fact that they rely
less on philanthropic funding, but also suggesting opportunities to integrate further into the network
• The top 50 most frequently named funders include 10 corporate entities, suggesting an opportunity to build more
alignment both with and within corporate philanthropy
This is a "beta" version analysis and there are a number of opportunities to further enhance it in future versions
• Expanding the number of organizations profiled to include a more comprehensive set of SEAD actors
• Exploring opportunities to standardize (and possibly automate) the process for collecting data
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The Landscape Analysis profiled 314 organizations with a direct or adjacent relationship to the social, emotional, and
academic development (SEAD) space
• Organizations were identified through interviews, a review of actors associated with the Commission and online
research, and are meant to represent a thorough (but not exhaustive) profiling of major actors in the SEAD space

Contents

Approach
Landscape actors
Key findings
Considerations for future analysis
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Defined
landscape

Categorized
organizations

Identified
relationships

Mapped
landscape

Conducted a Landscape Analysis of
the field via:
• Review of related research
reports and lit review
• Interviews
• Web search

Website review conducted for each
SEAD actor identified:
• Types of work and focus of
organization
• Publicly listed partners and
funders

Relationships between SEAD
actors were identified based on
partners and funders listed on
website

...in order to assess the state of
the field and identify key SEAD
actors

Categorized actors by primary
implementation lever based on
where actor was most featured in
the Landscape Analysis narrative

Used TouchGraph tool to produce
three types of relational maps:
• Relationships across SEADfocused actors
• Associations of individual SEADactors
• Trends across universe of listed
partners and funders

Organizations included1 based on:
• Interviews or research
• Association with a
Commissioner
• Part of partners collaborative2
• Funder of the Commission, or
funder that submitted data for
funder analysis

Categorized actors by degree of
SEAD focus based on • Interviews
• Initiatives featured on website
• Note: All members of partners
collaborative assumed to be
focused on SEAD

For each organization, up to 20
partners and funder were
captured – if more than 20
listed on website, collected 20
most related to the space /
likely to appear elsewhere in
the database

Relational mapping visualizes and
quantifies relationships with
partners and funders

1. Database for relational mapping based on organizations included In Landscape Analysis narrative as of 8/1/18. Some organizations added in final revisions of
Landscape Analysis narrative after was database locked were not included but flagged to add in the future 2. Based on partners collaborative list as of 10/20/17
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Using Landscape Analysis actors, several visualizations
of relationships were created

Backup | Detailed relational analysis methodology

Landscape Analysis and database of
organizations developed by reviewing
several key research reports and
conducting ~100 stakeholder interviews
Through research and interviews, 14
implementation levers identified around
which the Landscape Analysis was
organized (see appendix for description
of each lever)
The Landscape Analysis identified 314
organizations across the field1, some
explicitly focused on social, emotional,
and academic development and others
adjacent to the space with potential to
be more involved in the future
The list of organizations included in the
database were identified based on,
• Interviews or research
• Association with a Commissioner
• Part of partners collaborative1
• Funder of the Commission, or funder
that submitted data for funder
analysis

Identified
relationships

For each of the 314 organizations in the
database, the website was reviewed for
additional information on each
organization including a description,
mission, etc. All data is available in the
accompanying Landscape Analysis Field
Actor Database

Relationships between the organizations
were identified based on publicly listed
partners and funders on the organizations
website • Collected names of organizations that
were listed clearly on website, usually
on tab labeled "Partners", "Funders",
"Investors", etc.
• Captured up to 20 partners and funder
for each organization – if more than
20 listed, collected 20 most related to
the space / most likely to appear
elsewhere in the database
• It is possible that the organizations
have partnerships not listed on the
website or not apparent through the
methodology followed
• Note: funders in the database were
not researched as outlined but were
captured to the extent to which they
surfaced on other field actor websites
(see more detail on approach to
funder analysis below)
Separate funder analysis conducted with
data on investments submitted by funders.
For relational mapping exercise, funders
show up in the map only to the extent to
which they are listed by other actors

Organizations identified were then
categorized across implementation
levers, e.g. technical assistance, preservice training, etc.
Organizations were also categorized
based on their focus on SEAD. Of the
original 314 actors, 224 were primarily
or partially focused on SEAD
Categorization of actors was done using
several sources of input, including:
• Interviews
• Initiatives featured on website
• Note: All members of partners
collaborative assumed to be focused
on SEAD at least partially

Mapped landscape
TouchGraph Navigator leveraged to build
three types of relational maps:
• Relationships across SEAD-focused
actors
• Associations of individual SEAD-actors
• Trends across universe of listed
partners and funders
Additional detail on how to load and use
the database to build the visualized map
is included at the end of this document
Please note:
• This methodology limits the map to
organizations identified through our
Landscape Analysis, which is not an
exhaustive list of actors in the space
• The website review limits the map to
connections explicitly stated as
partnerships / funding relationships
online
• Therefore, this analysis is a starting
point to draw connections among the
actors in the Landscape Analysis
database, but is not a complete view
of relationships across the field

1. Database for relational mapping based on organizations included In Landscape Analysis narrative as of 8/1/18. Some organizations added in final revisions of
Landscape Analysis narrative after was database locked were not included but flagged to add in the future 2. Based on partners collaborative list as of 10/20/17
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Defined landscape

Categorized
organizations

Relational map can be used to observe trends across broader Landscape and
for individual SEAD actors
Across network of SEAD actors in
Landscape Analysis

2

For individual SEAD actors in
Landscape Analysis

3

Identifies which SEAD actors are most
connected across the field

Identifies relationships between
specific SEAD actors in the landscape

Identifies trends across listed partner
and funder organizations in terms of
organizations that appear most
frequently

Can highlight:
• Degree of connectedness /
specific relationships with other
SEAD-focused actors
• Total number of associations
• Implementation lever

Can highlight:
• Number of relationships within
network
• Distinctions between partner
and funder ties
• Implementation lever

Can highlight:
• Most commonly occurring
partner / funder organizations
(including those that are not
SEAD-focused)

8
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1

Across partners & funders named
by SEAD actors in Landscape
Analysis

Agenda

Approach
Landscape actors
Key findings
Considerations for future analysis
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224

105

803

SEAD-focused
actors1 profiled
in Landscape
Analysis

Of the SEADfocused actors
were named as
partners or
funders for other
SEAD-focused
actors

Additional unique
orgs. were
named by SEADfocused actors as
partners or
funders

1. Includes all actors profiled in Landscape Analysis for which SEAD is either a as primary focus or core to at least some work/initiatives.
Note: 314 total actors reviewed in Landscape Analysis (of which 224 had primary or partial SEAD focus). of the 224 SEAD-focused actors, 127 listed at least 1
partner or funder and 73 did not list partners or funders on their website. The remaining 24 SEAD-focused actors were philanthropic organizations for which
websites were not reviewed for partners/funders based on the methodology.
Source: Landscape analysis stakeholder interviews, BCG Analysis
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Through Landscape Analysis, profiled 224 SEAD-focused actors that identified
908 unique partners & funders

224 SEAD-focused organizations: Categorized by implementation lever
Implementation Lever
36

School & program design models, curriculum, and other tools

22

National and regional associations 1

3
13

Local coalition building and high visibility public campaign(s)
(comms., advocacy and engagement)

8

5

3

11
8

8

Pre-service training 1
Social media engagement and educator-led networks
(comms., advocacy and engagement)

2

4

Conveners - aligning and convening the field

2

2 4

Youth voice and leadership
(comms., advocacy and engagement)

13

10

Public funding and advocacy 1

21

13

9

4

Networks

22

14

5

In-service training

23

9

7

Technical assistance

9
6

1
0

SEAD is primary focus

23

20

Continuous improvement systems, measurement and research

70

Some SEAD work/initiatives

10

20

30

40

50

60

70

# of SEAD Actors
11

Source: Landscape analysis stakeholder interviews, BCG Analysis
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Philanthropic funding

34

WA

6

MT

2

OR

ID
SD
1

NV
CA

WI

2

IA
IL
1

CO

KS

1

NY

MO

6

1

MI

NE
UT

PA
2 OH

IN
1

10

AZ

1

OK

NM

6

TX

MS

NC
2

1

2

AL

GA

NJ
DE
MD
DC
WV

21

35

4

SC

FL
1

Note: Excludes 15 of 224 SEAD actors for which HQ location was not identified.
Source: Landscape analysis stakeholder interviews, BCG Analysis

1

NH
VT
MA
RI
CT

LA
1

of SEAD actors profiled in Landscape Analysis with HQ in state

3

VA
14

1 TN

AR 2

6
5

1

KY
1

1

25

MN
WY

37

ME

ND

Majority of organizations
located on east or west coast;
(further analysis required to
understand extent to which
due to selected sample or
reflective of true
concentration of orgs)

Other HQ locations
England

1

Switzerland

1

North America/ US multi-state

3
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224 SEAD-focused organizations: Categorized by HQ location
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Landscape actors
Key findings
Considerations for future analysis
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Preliminary findings and potential opportunities from
relational mapping
Relational mapping identified some anticipated concentrations of actors across the SEAD landscape
• Philanthropic organizations and funders are very well connected and central to the map
• Organizations focused on aligning and convening the field also cluster in the center, as well as research institutions given their close association to
philanthropy
• TA providers as well as professional development actors are less central to the network and could be more connected to each other and to the SEAD
landscape
• National and regional associations have a high number of associations but are also on the periphery of the network. This is driven by fewer
relationships with funders and with SEAD-focused actors suggesting an opportunity to integrate more with the SEAD community, in particular to
broaden geographic scope of work
Overarching map also highlighted 81 SEAD-focused actors that are not connected to the central network map, which may be a function of these
organizations not listing partners or funders on their website (although they would still appear connected if other actors listed them as partners/funders)
but could also represent certain silos in the field that could be more integrated
• For example, Dignity in Schools and the National School Climate Center, which both represent important adjacent approaches/movements, are not
connected to the central network map
2

There are a subset of actors that are particularly well connected across the field
• Big Brothers Big Sisters has the most associations of any organization (34) but only 4 connections with other SEAD actors suggesting an opportunity to
integrate more with the SEAD community
• CASEL is unsurprisingly the most well connected organization with a primary focus on SEAD (24 associations)
• The Gates Foundation is the most well connected funder with 29 total associations, 18 across the profiled set of SEAD-focused actors

3

Review of the organizations named by SEAD actors as partners and funders suggested further opportunities for collaboration
• The set of partners and funders is fairly fragmented with 725 partners/funders mentioned only one time and accounting for 52% of total mentions
• 20% of the top 50 named partner/funder orgs are corporate entities. Given active participation from the business community in this work, opportunity
exists to further engage this segment across many dimensions including thought-leadership and expertise, partnership and funding opportunities
14
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1

Concentration of SEAD relationships

64% of SEAD-focused actors connected through existing funder and partner
relationships
143 of 204 SEAD-focused actors
connected in central map of
field actors

81 of 224 SEAD-focused actors
not connected to central map
of field actors due to either
not listing partners or funders
on website OR not listing
partners or funders that
overlap with central map of
actors
Majority of these actors (57%)
did not list partners or funders
on website

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that
connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.
Source: Landscape analysis stakeholder interviews, BCG Analysis

15

Copyright © 2018 by The Boston Consulting Group, Inc. All rights reserved.

1

Concentration of SEAD relationships

Relational network map of all interconnected SEAD actors

Color of box organized by primary lever
Continuous improvement systems, measurement
and research
Conveners - aligning and convening the field
In-service training

National and
regional
associations
cluster together
towards
periphery of
map – not as
well connected
to SEAD-focused
actors

Philanthropic organizations tend to be
well connected / have high number of
associations so cluster towards center

Local coalition building & high visibility public
campaign(s) (comms, advocacy and engagement)
National and regional associations
Networks
Philanthropic funding
Pre-service training
Public funding and advocacy

Organizations that align and convene
the field as well as those involved
with research are somewhat clustered
together towards the center

School & program design models, curriculum, and
other tools
Social media engagement and educator-led
networks (comms, advocacy and engagement)
Technical assistance
Youth voice and leadership (comms, advocacy and
engagement)

TA providers are generally
less-well connected, and thus
do not appear in the center
of the map

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that
connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.
Source: Landscape analysis stakeholder interviews, BCG Analysis
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1

Concentration of SEAD relationships

Relational map snapshot: Philanthropic funding
Location of Philanthropic organizations in network map
Philanthropic
funding

Philanthropic organizations central to network map,
representing large influence across broader landscape
of SEAD actors
23 total SEAD-focused philanthropic organizations
captured in network map
• 20 connected through central network map
• 3 not connected (due to not being listed by another
actor as a partner or funder)
Philanthropic organizations central to map (not
surprisingly) due to high number of associations with
SEAD-focused actors. Most connected funders include • Bill and Melinda Gates Foundation (29)
• The Wallace Foundation (20)
• William and Flora Hewlett Foundation (20)
• Carnegie Corporation of New York (19)
• Einhorn Family Charitable Trust (14)

Several philanthropic
organizations central
to network map
17
Note: Philanthropic organizations appear in network map only if listed by other organizations as partners or funders. The websites of philanthropic organizations were not reviewed for listed partners or funders as more
detailed information was captured as part of separate funder analysis; total associations equal to number in right hand corner of actor minus 1, Source: Landscape analysis stakeholder interviews, BCG Analysis
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1

Concentration of SEAD relationships

Relational map snapshot: Additional central actors include those focused on
research and convening
Location of research-oriented and convening
organizations in network map
Conveners - aligning and
convening the field

Continuous improvement
systems, measurement
and research

Research-oriented actors and conveners, pulled towards
center through funding relationships
22 total SEAD-focused actors related to continuous
improvement systems and research captured in network
map
• 11 connected through central network map
• 11 not connected (due to either no listed partners or
funders or no overlap with other actors in network
map)
These organizations are pulled centrally due to close
connections with specific philanthropic organizations (vs.
many associations across SEAD-focused actors)
• For example, MeasuringSEL has 10 connections to SEADfocused actors, 6 of which are to funders
4 SEAD-focused actors related to aligning and convening
the field, with the National Commission, CASEL and the
National Public Education Support Fund all clustering
towards center

Note: Total associations equal to number in right hand corner of actor minus 1
Source: Landscape analysis stakeholder interviews, BCG Analysis
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1

Concentration of SEAD relationships

Relational map snapshot: TA Providers
Location of TA providers in network map

Primarily located around periphery, suggesting
opportunity for great collaboration with SEAD actors

Technical assistance

Communities in Schools and
Search Institute

Every Hour
Counts

Note: Total associations equal to number in right hand corner of actor minus 1
Source: Landscape analysis stakeholder interviews, BCG Analysis

21 total SEAD-focused TA providers captured in network
map
• 14 connected through central network map
• 7 not connected (due to either no listed partners or
funders or no overlap with other actors in network map)
SEAD-focused TA providers tend to cluster throughout
periphery of map, suggesting more limited connections
across SEAD actors; TA providers with the greatest
associations include • Communities in Schools (24)
• EducationCounsel (22)
• Search Institute (20)
• Every Hour Counts (19)
Small number of TA providers connected to other TA
providers, e.g. Every Hour Counts connected to both
Partnership for Children and Youth and ExpandED Schools
• May suggest opportunity for greater collaboration (but
likely due to TA providers not listing other TA providers on
19
website)
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1

Concentration of SEAD relationships

Relational map snapshot: Other peripheral actors in network map
Location of national and regional associations and
training actors in network map
Relay GSE

San Jose University
Collaborative for
Reaching and Teaching
the Whole Child

Primarily located around periphery, suggesting
opportunity for great collaboration with SEAD actors
22 total SEAD-focused pre-service or in-service training
actors captured in network map
• 12 connected through central network map
• 10 not connected (due to either no listed partners or
funders or no overlap with other actors in network map)
The most well-connected of these actors include San Jose
University Collaborative for Reaching and Teaching the
Whole Child (22) and Relay GSE (21)

National and regional
associations

23 SEAD-focused national and regional associations
captured in network map
• 16 connected through network map
• 7 not connected (due to either no listed partners or
funders or no overlap with other actors in network map)

Pre-service training
In-service training

These organizations cluster tightly together on periphery of
map suggesting they are well connected to each other but
less so with broader pool of SEAD-focused actors captured
20

Source: Landscape analysis stakeholder interviews, BCG Analysis
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1

Most well connected SEAD actors

Organizations with most connections reflect diverse group with national
breadth, 30% are primarily SEAD focused
Primarily focused on SEAD
TOTAL # of Connections
Big Brothers Big Sisters
National PTA
National Association of Elementary School Principals
National Network of State Teachers of the Year (NNSTOY)
Mentor (The National Mentoring Program)
City Year
Bill
&
Melinda
Gates
Foundation
30% of most connected
Solutions Not Suspensions
actors are primarily
the YMCA
focused on SEAD
Communities in Schools
CASEL
Facing History and Ourselves
Turnaround for Children
EducationCounsel
National Association of State Boards of Education (NASBE)
Reading Apprenticeship
San Jose University Collaborative for Reaching and Teaching the Whole Child
Relay GSE
The Wallace Foundation
William and Flora Hewlett Foundation

Color of name organized by primary lever
34
33

Continuous improvement systems, measurement
and research

32
31

Conveners - aligning and convening the field
In-service training

31

Local coalition building & high visibility public
campaign(s) (comms, advocacy and engagement)

29
29

National and regional associations

26
24

Networks

24

Philanthropic funding

24
23
23

Pre-service training
Public funding and advocacy
School & program design models, curriculum, and
other tools

22
22

Social media engagement and educator-led
networks (comms, advocacy and engagement)

22
22
21

Technical assistance

20
20
0

10

20

Youth voice and leadership (comms, advocacy and
engagement)

30

40

# of unique connections
Note: Connections counts number of funders and partners named by the SEAD actor on website as well as when they were named by other actors. Total
associations reported in Toughgraph includes actual field actor, therefore # of connections is equal to Touchgraph number minus 1 (as reported here)
Source: Landscape analysis stakeholder interviews, BCG Analysis
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2

2

Most well connected SEAD actors

Total associations based on entire map of actors (not just SEAD-focused)
Big Brothers Big Sisters with most total associations
(34) but only ~4 to SEAD-focused actors

Bill & Melinda Gates Foundation with fewer total
associations (29) but greater number of connections
to SEAD-focused actors

Note: Total associations
equal to number in top
right hand corner minus 1
(number shown includes
SEAD-focused actor)

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that
connected them to other organizations in the SEAD-focused map. There are additional organizations in the database that do not appear in this view.
Source: Landscape analysis stakeholder interviews, BCG Analysis
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Dotted lines represent funder associations, solid
lines represent partner associations

Concentrated partner & funder universe

While certain partners and funders mentioned multiple times by SEAD-focused
actors, majority of listed partner or funders appear only once
Total number of mentions by SEAD-focused actors as partners or funders
800

725

Long fragmented tail as
~52% of total named
partners/funders are
mentioned only once in
review of SEAD
relationships

600
400

368
196

200

105

0

Unique named
partners & funders

Named by 4+ SEAD actors

Named by 3 SEAD actors

50

35

Named by 2 SEAD actors

98

Named by 1 SEAD actor

725

~85 partners/funder orgs
were mentioned 473 times
(34% of total) by SEAD orgs
1. Across 224 SEAD-focused actors in Landscape Analysis
Source: Landscape analysis stakeholder interviews, BCG analysis
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3

6
6
6
6
6
4
4
4
4
4
4
4
4
4
4
4

New Schools Venture Fund
Lumina Foundation
New Teacher Center
America’s Promise Alliance
Chicago Public Schools
Bezos Family Foundation
Council of Chief State School Officers (CCSSO)
Deloitte

Annie E. Casey Foundation

4

Mentor (The National Mentoring Program)

Google

4

The James Irvine Foundation

5

StateFarm

5

the YMCA

5

Walmart

5

Pearson

0
5

Target

6

William T. Grant Foundation

Bank of America

6

Charles Stewart Mott Foundation

6

Ewing Marion Kauffman Foundation

6

Comcast Corporation

6

Ashoka

5

Altria Group

Partners & Funders named by 4+ SEAD actors
10 corporate partners/ funders in top 50 present
potential opportunity to engage more directly as
part of funder group going forward

24

Copyright © 2018 by The Boston Consulting Group, Inc. All rights reserved.

7

CASEL

7

Overdeck Family Foundation

7

New York Life Foundation

7

AT&T

7

Charles and Lynn Schusterman Family foundation

Partners / funders that are mentioned most
frequently are highly concentrated with
philanthropic organizations
7

Americorps

7

American Institutes for Research (AIR)

7

Chan Zuckerberg Initiative

15

National Science Foundation

18 18

Nellie Mae Education Foundation

# of connections with SEAD actors

W.K. Kellogg Foundation

8

Spencer Foundation

8

Stuart Foundation

9

Walton Family Foundation

9

Microsoft

10
10

NoVo Foundation

11

Robert Wood Johnson Foundation

12 12

Raikes Foundation

Ford Foundation

13

S.D. Bechtel Jr. Foundation

15

Carnegie Corporation of New York

16 16

William and Flora Hewlett Foundation

Einhorn Family Charitable Trust

US Department of Education

Bill & Melinda Gates Foundation

20

The Wallace Foundation

3
Concentrated partner & funder universe

Top ~50 partner/funder orgs named by SEAD actors include concentration of
major foundations as well as multiple corporates
Non-profit

Education-focused entity

Corporate entity

Government entity

Philanthropic Foundation

SEAD actor (included in 224 database)

Agenda

Approach
Landscape actors
Key findings
Considerations for future analysis
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Next steps for Landscape Analysis
Hand over to National Commission staff for near-term ownership
• Distribute through website and as appropriate through partnership channels

Finalize process for updating over time including any additional information to
capture as part of Landscape Analysis (See following page for more details)
• Update annually through comprehensive refresh process
• Consider automating components of process given labor-intensity
• Several potential ways to extend analysis, e.g. greater breadth of actors captured,
additional data fields

26

Copyright © 2018 by The Boston Consulting Group, Inc. All rights reserved.

Determine long-term owner of Landscape Analysis
• Likely successor coalition or member(s) of funders collaborative

Four main areas to refine and enhance Landscape
Analysis going forward

Refine the analysis to ensure greater accuracy
• Capture information on partners and funders for organizations that do not publicly name those relationships
on their website
• Refine categorization by implementation levers based on further socialization with stakeholder community
Collect and analyze additional data fields. For example:
• Board member composition including demographic information
• Associated frames used by organization
• Years of operation
• Student/youth populations served including age range, demographics, etc.
• Organizational size and scope, e.g. budget, number of school districts served
Enhance approach for collecting data
• Create more defined process for collecting data systematically from universe of SEAD actors (e.g., survey)
• Consider automated methods for capturing data (e.g., webscraping)

27
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Expand the universe of profiled actors
• Include broader set of stakeholders including more from adjacent movements
• Extend reach to more consistently capture regional and local actors
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Appendix

Relational network map of all SEAD-focused actors from Landscape Analysis

Color of box organized by primary lever
Continuous improvement systems, measurement
and frameworks
Conveners - aligning and convening the field
In-service training
Local coalition building and high visibility public
campaign(s) - comms, advocacy and engagement
National and regional associations
Networks
Philanthropic funding

The total number of associations listed
for the organization is indicated in the
upper right corner; associations not
part of Landscape Analysis database
not shown but included in total
partnerships. Note this number
includes the actor listed so true
associations to other partners or
funders is equal to N-1

Several actors (81/224) not
shown because not connected
through a particular funder or
partner within map of actors

Pre-service training
Public funding and advocacy
School & program design models, curriculum,
and other tools
Social media engagement and educator-led
networks – comms, advocacy and engagement
Technical assistance
Youth voice and leadership - communications,
advocacy and engagement

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that
connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.
Source: Landscape analysis stakeholder interviews, BCG Analysis

29

Copyright © 2018 by The Boston Consulting Group, Inc. All rights reserved.

Each SEAD-focused
organization from Landscape
Analysis database appears as a
box on the map

Each organization can be viewed in isolation in the mapping tool
Solid line connection
represents a partner
relationship
Color of box organized by primary lever
Continuous improvement systems, measurement
and frameworks

In-service training
Local coalition building and high visibility public
campaign(s) - comms, advocacy and engagement
National and regional associations

Number represents total number
of associations including existing
field actor, e.g. 2 (only
associations with SEAD-focused
actors shown in map)

Networks
Philanthropic funding
Pre-service training
Public funding and advocacy
School & program design models, curriculum,
and other tools
Social media engagement and educator-led
networks – comms, advocacy and engagement
Technical assistance
Youth voice and leadership - communications,
advocacy and engagement

Dotted line connection
represents a funding
relationship

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that
connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.
Source: Landscape analysis stakeholder interviews, BCG Analysis
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Conveners - aligning and convening the field

Excel database of actors includes variety of information on each organization,
and is the input to TouchGraph Navigator to create the relational map

Organization name
and acronyms

Website link

Organization CEO /
President

Description of
organization's work

Mission /
geographic focus

Organization
headquarters
location & year of
inception

Associated change
levers
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Level of SEAD focus
(e.g., SEAD primary
focus, some SEAD
work)

Landscape Analysis framed around ~14 implementation levers identified
through Commission's work and stakeholder conversations (I/II)

i

Implem
entation
levers

ii
Encourage
creation of new
school models
and enhance
marketplace of
integrated social,
emotional and
academic-related
products and
services, e.g.,
curriculum,
technology, etc.
to drive high
quality
implementation

Continuous
improvement
systems,
measurement
and frameworks

Technical
assistance

Create and roll iii Expand supply iv
out a broadened
of high quality
set of systems
technical
and tools for
assistance to
measurement of
districts and
social,
the out-ofemotional and
school time
academic
sector, building
learning
implementation
environments
capacity

Networks

v
Build capacity
and buy-in of
place-based
networks and
equip with
resources to
support local
adaptation and
implementation

Pre-service
training

vi
Redesign
educator
preparation
programs to
balance
knowledge of
standards with an
understanding of
youth
development and
transform vision
for school
learning
environments

In-service
training

Focus
leadership and
educator
development
providers'
programs more
explicitly on
developing
adult capacity
in social,
emotional and
academic
domains

32

Copyright © 2018 by The Boston Consulting Group, Inc. All rights reserved.

Implementation

School &
program design
models,
curriculum, and
other tools

Landscape Analysis framed around ~14 implementation levers identified
through Commission's work and stakeholder conversations (II/II)
Public funding

Philanthropic funding

vii Promote increased and more flexible federal and state

resources to support integrated social, emotional and
academic development in a way that ameliorates existing
disparities

viii Coalesce and integrate catalytic resources around highest

priority implementation opportunities and questions across
practice, policy and research

ix Mobilize youth voice and leadership to actively drive national and local implementation agenda

Implem
entation
levers

Grow familiarity, alignment and commitment of families, parents, caregivers and grass-roots organizations in local communities

x through balance of local coalition building and high visibility public campaign(s) with clear, consistent messaging

Engage educators to spread best practices and awareness about social, emotional and academic development through social

xi media engagement and educator-led networks

xii Engage and advocate to local, state and federal policy makers to enhance and create supportive conditions for implementation

Aligning and convening the field
xiii Ensure social, emotional and academic development is prioritized on agenda of major national and regional associations within
the education and out-of-school time (OST) sectors

xiv Develop a more aligned, diverse and inclusive field by encouraging ongoing collaboration and continuous improvement
33
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Implementation

Communications, advocacy and engagement
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Touchgraph Navigator overview

Touchgraph Navigator

• The tool is capable of displaying combinations of individuals,
organization, and publications, as well as the connections
between these types of network nodes
• In addition to various combinations of network node types,
the tool can also show varying degrees of the network – from
the full, high level shape of the network, to detailed, drill
down networks of single individuals and organizations
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• Touchgraph Navigator is a tool used to visualize networks. It
is typically used for mapping projects to display different
views of the networks from an organizational database

• Organizations
• Individuals
• Published articles

Types of
connections

• Co-membership—organizations connected by common
individuals between the different organizations
• Co-authorship—individuals connected by co-authoring a paper
together. Results in the organizations the authors belong to
being linked as well
• Direct relationship—organizations or individuals connected by a
direct (forced) link

Level of
detail

• Capable of showing high level view of the network with up to
10K individuals and organizations (general shape, overall view
of connectivity)
• Ability to drill down to a single individual and organization,
click on a single link or node and view underlying data

Touchgraph Navigator
capabilities overview
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Types of
network nodes

Touchgraph Navigator
Introduction to major processes

Loading dataset

Navigate to
Excel data
file
37
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After installing and launching Touchgraph, navigate to File -> Open
Wizard and locate the Excel data file you wish to use

Touchgraph Navigator
The data panel

The window in the
upper left shows
more detailed data
for any node that is
selected

The different
attributes chosen
when creating the
original settings file
determines what
information is
displayed in the
different columns
Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.
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The left hand side of the tool has a data table organized into
two tabs with a drop down to navigate further
• Entities—Includes information about all defined entities
and their attributes
– Organizations
• Relations—Includes information about all defined
relationships between entities and their attributes
– Organization to funder relationship
– Organization to partner relationship
– Organization's primary lever
– Organization's level of focus on social, emotional,
and academic development

Touchgraph Navigator

The user settings panel: filter inclusion and attribute filter

Check to include different
types of connections in
the network

Set condition to exclude or
include based on attribute
Filter > Attribute Filters
lets you set criteria for
inclusion in the network

Select what entity or
relation you would like
to filter on (Example:
number of associations)
Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.

Select the filter thresholds

Select what attribute you
would like to filter on
(Example: at least one
partner or funder to show
in network map)
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Filter > Inclusion tab lets
you determine what is
displayed in the
network visual

Touchgraph Navigator

The user settings panel: node appearance
Select the Node Type and
use the drop down to select
color options
Node Colors, Size, Labels and
Tags can all be modified
under the Node Appearance

Select whether
to display a halo
use the slider to
scale size

Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.
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Select what
attribute the
node size will be
correlated to

Node labels (content and
appearance) can be
changed under Node >
Label/Image

Touchgraph Navigator

The user settings panel: edge appearance

Select the EdgeType and
use the drop down to select
color options

Select what
attribute the
edge width will
be correlated to

Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.

Select whether to display
the edge and use the
slider to scale width
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Edge Colors, Width, and Tags
can all be modified under the
Edge Appearance

Amount of network nodes to show
All: all nodes that meet
requirements in filter settings
Single: single selection of nodes
Degrees of separation: how many
steps to take along the network
from the starting node(s)

Coloring tool to
manually color a
selection of nodes
(Example: an entire
category of nodes that
were selected in the
left data panel)

The user settings panel: top bar

Zoom and spacing controls
to manipulate the display
of the network

Play/Pause toggle—press play
to let the program optimize
the display of the network.
When want to manually
manipulate the network with
the hand tool, first pause
the display.
Pausing also allows for
quicker operation
without bogging down
computer resources
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Touchgraph Navigator

